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Welcome to DECK I12.2! This addendum brings your DECK 112.0
manual up-to-date. OSC has continued to improve DECK II. The release
of version 2.2 of DECK II includes the following powerful new features:

e Support of up to 12 tracks on a Power Macintosh with no addi-
tional hardware. (12 tracks on a 8100/80, 10 tracks on a 7100 and 8
tracks on a 6100).

« Support of 840 AV (8 tracks) and 660 AV (6 tracks) Macintoshes

Up to 16-track upgrades available for a single Pro Tools system

(requires the OSC 16-Track Tool and a Power Macintosh)

MIDI file playback from within DECK I

Virtual Track mixing

Region Library window for tracking source material

Enhanced digital video (QuickTime) features, including scrub-on-

picture and scrub picture to spot

Support of QuickTime 2.0

Support of the WAVE soundfile format

o Enhanced 8-bit audio mixdown (dithering and rounding)

HARDWARE REQUIREMENTS

In order to install and use DECK II, you will need:
1) A Power Macintosh, Macintosh 840AV or 660 AV .
Or, if you do not have an 840AV or 660AV:

a) A NuBus or PDS Slot-capable Macintosh running System 7.1
or higher and QuickTime 1.5 or higher.

AND:

b) Digidesign’s Audiomedia, Audiomedia LC, Audiomedia II, or
Sound Tools IT or Pro Tools system or RasterOps' MediaTime
system or Spectral Innovations' NuMedia system.

2) DECK II requires a Macintosh with 8MB RAM. OSC recommends
12MB RAM or more for those wishing to run DECK I, Metro and
OMS concurrently.
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3) A hard disk with the following specifications: 12 ms access time
(8 tracks); 18ms for 6 tracks; 27ms for 4 tracks and 1.2MB/second
SCSI throughput (8 tracks). Drives with hard-wired thermal
recalibration routines should be avoided, as they can cause
problems on long sustained transfers.

4) For PowerMac and AV users, SCSI Manager 4.3 compatible
drivers (which support asynchronous dish 1/0) are highly
suggested.

All other requirements are the same as those listed in your original
DECK II user manual.

OSC’S UPDATE AND SUPPORT POLICY

As a DECK Il owner, the first action you should take is to send in your
registration card. You must be a registered owner if you want to receive
telephone support, program updates, or new product information.

Once you are a registered owner, program updates will be made avail-
able to you free, or for a minimal charge (depending on the nature of the
update).

OSC is serious about customer support, and is strongly committed to a
continuing relationship with you after your purchase.

Please feel free to contact OSC directly with any questions or problems.
A DECK II consultant will be standing by to help you during business
hours (Monday to Friday, 8:00AM to 4:00PM PST). For DECK 1I cus-
tomer service, call (617) 969-0754 or FAX (617) 928-0038. Remember to
have your DECK Il master disk handy when you call or FAX.

You may also contact us through CompuServe. You will find us in the
MIDI Vendors C forum (Type "GO MIDL.")

OSC is made up of people who are very interested in audio, sound
design, and the recording process as a whole. Become one of our regis-
tered owners and participate in the creative process.

Note: OSC Technical Support can only return telephone calls to
customers calling from within the United States and Canada. Custom-
ers outside of the US and Canada must contact their respective distribu-
tors for technical assistance with OSC products.
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8-TRACK TOOL AND 16-TRACK TOOL OWNERS

If you have purchased the 8-Track Tool or 16-Track Tool from OSC for
use with your supported hardware (Pro Tools systems), be sure to install
it according to instructions. Whenever you read "four active playback
tracks" in this manual, remember that you have up to 16 active playback
tracks.

INSTALLING YOUR DECK Il SOFTWARE

To install the DECK II software on your hard disk:
1) Restart your Macintosh while holding the Shift key down.
This will prevent your System Extensions (INITs) from
booting and possibly interfering with the installation pro-
cess.
2) Put the DECK II diskette into any drive.

An open diskette window will appear on your Desktop.

3) Double-click on the DECK II Installer application icon. This
dialog will appear:

4) Click on the Continue button. The following dialog appears:
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5)

PLEASE READ these Release Notes for DECK I1™ version 2.2,
Hello and welcome to the newest version of DECK, DECK 11 22! DECK I is not just af::
imple update to OSC's eriginal DECK program - it's & whole new application that %
akes original DECK functions inte the world of the digital audic workstation. And ?
this version fully supports the 6 tracks on a Macintosh 660av, 8 tracks on an 840av £

nd 8 - 12 tracks on a Power Macintosh with all DECK features - NO AUDIO CARDS
REQUIRED. DECK II offers:

¢ Non-destructive recording

Multitrack visual waveform editing with full spot and slip ability

24-bit moving fader automation

Visual editing of automation envelopes

Synchron QuickTime movies from disk in a window

Four in/four out on Sound Tools II

Continuous SMPTE resynchronization

Direct links to supported sequencers (such as 05C’s METRO) for synchronous

(Csave... ) (_Print... ) (_cencel [[Continue |

This dialog contains basic information and notes about the
release. You can choose to print these notes out (using the
Print button) or save them to any disk as a text file (using the
Save button). These Release Notes contain important
information that is not found in this User’s Guide. Spending
a few minutes now looking over the documentation may
save you considerable frustration later.

When you have read the release information, click on the
Continue button. This dialog will appear:

Install the following:

Full Install for all platforms

Digisystem Install

51
2
AV, Numedia & Power Macinlosh Install %
R

DECK 11" Install
Y Installs DECK 1l and all required extensions and support files for
o Al supported platforms

Installation requires . 960K

[ owit  J| instan ||

Use this dialog to select the type of installation you desire.
You can always choose the "Full Install for All Platforms"
option, if you are unsure of your audio hardware, but it is
suggested that you choose the installation that is specific to
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6)

7)

the type of audio hardware you have. (If you have no add-
on audio hardware, select the AV, PowerMac and NuMedia
installation.) If you are simply updating your copy of the
DECK II software, and you are sure that you have the correct
version of all system software installed, then you can choose
the "Install DECK II" option.

Make sure you have selected an installation type, then click
on the Install button. This dialog will appear:

©ProsStore
fADirector 4.0 B { Eject ]
EAExncel
E3From Ben Desktop
FAMaelstrom 1.4.1 § New [
£ Fiessattager L8
Install software into folder:
DECK 1™ 2.2 R [Cinstan_)

Use this dialog to select the destination folder for your new
DECK II folder.

Choose a destination and click on the Install button.

A DECK II folder will be created at your chosen destination,
and a copy of DECK II will be placed into that folder.

DECK II uses a simple copy protection scheme that allows
you to 'authorize’ up to 2 hard disks. You can run your
DECK II software on any authorized hard disk, and you can
move your DECK II software between any authorized hard
disks. Authorized hard disks can be optimized with no risk
to the software.

You can also 'deauthorize' any hard disk using your DECK II
master diskette, in order to return to your original authoriza-
tion count. Then you are free to authorize other drives. You
can de-install by following the above instructions, but
instead of choosing DECK II 2.2 Install in step 6, choose
"Deauthorize DECK IL."
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8) Restart your Macintosh.

Your software is now installed, and you’re ready to begin working
with DECK 1I..

WARNING: Like many CPU-intensive programs, DECK II does not
run well with File Sharing turned on. Although DECK II will run with
File Sharing on, its performance will be greatly degraded. For better
results, make sure file sharing is turned off before you begin your DECK
II Session.

Your hardware and software is now installed, and you're ready to begin
working with sound. The only thing you still need to do is hook up
audio inputs and outputs. The user manual tells you how to do this.

CONFIGURING DECK Il AND SETTING MAXIMUM
PLAY TRACKS

Generally, DECK II version 2.2 is quite similar to version 2.0 where basic
functions are concerned. Since the major difference between the two
software versions is compatibility with new hardware systems, it is
important to take note of some simple configuration steps when install-
ing and setting up version 2.2. The configuration issues are two-fold:
First, you must make sure your copy of DECK II is set to find the correct
hardware (which usually occurs automatically). Second, you may need
to set the number of playback tracks. (This is especially true if you are
updating to version 2.2 from an earlier version of DECK I, or if you are
installing the 8-Track Tool or 16-Track Tool.) Here are directions for
accomplishing these tasks:

To set your version of DECK II to the correct hardware:
1) Start up your copy of DECK II.

2) Choose the Hardware Configuration command on the
Options menu. This dialog will appear:
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ardware Configuration

RAudio Card:[ Sound Manager PPC_w |

Sy Mida i

£ 1 @ Inpud Ripe. Tl
Dot Poneat

[ ™ic input On

[ ox )| [cancel)

3) Use the Audio Card pop-up at the top of this dialog to select
the hardware you will be using to record and play back
audio.

If you have only one option (such as PowerMac or AV

Macintosh) no options will be available, and the correct

hardware will be selected and indicated automatically.
Note: If you are running an Audiomedia II card in a Quadra 950,
Macintosh AV or Power Macintosh, make sure to choose the AMII
NuBus 90 option. This is required due to the faster NuBus in those
machines.

4) Click on the OK button to finish the configuration.

To set the track count on your version of DECK IT 2.2:
1) Start up your copy of DECK IL.

2) Choose the Memory and Storage preference on the File
menu's Preferences submenu. This dialog will appear:

@® Never
O Always
QO When recording 2 or more tracks

Disk buffer Kbytes
Man, play tracks: |12

Automation butfer: |3072 events

MIDI buffer: (20000 events

1]




3) Set the Max. Play Tracks to your desired number. Remem-
ber, these are the maximums: Audiomedia card — 4 tracks,
Sound Tools II card — 4 tracks, Pro Tools cards — 4 to 16
tracks (with the 16-track tool), Spectral Innovations
NuMedia cards — 6 tracks, 660AV — 6 tracks, 840AV —8
tracks, PowerMac 6100 — 8 tracks, PowerMac 7100 — 10
tracks, PowerMac 8100/80 — 12 tracks.

You can always set the maximum play tracks to a number
below the actual maximum available. This is advised if you
experience "Disk is too slow" messages, or poor interface
response.

Remember, optimum track count can depend on many factors, such as
the speed of your drive, the speed of your CPU, and the model of your
Macintosh. Using your System drive to record and play media on AV
and Power Macintoshes will also decrease your system performance
(due to System software design). On such systems OSC recommends use
of a non-System hard disk for media recording and playback.

When Power Macintoshes are used, it is OSC policy to allow each user to
set their individual maximum track count, rather that limiting track
count artificially. As Power Macintosh CPUs and hard disks grow faster
{and users upgrade their systems), this scheme allows users to increase
their track count immediately, rather than waiting for software updates.

INTRODUCTION TO NEW MIDI FUNCTIONS

DECK II is primarily a multitrack hard disk recording, editing and
mixing environment, but DECK II offers the ability to augment your
system with the use of MIDI. This chapter of the DECK Il manual
focuses on the specific tasks you'll need to understand, in order to get
the most out of DECK II's MIDI functions. Using the MIDI functions will
enable you to synchronize your Session to SMPTE timecode, use DECK
II as a master timecode source, import a MIDI file for synchronous
playback with your Session, and control DECK II with an external MIDI
device. You can also use OSC's METRO sequencer (or any other capable
sequencer) to edit MIDI files and digital audio at the same time.
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MIDI Preferences

The next step in configuring your system for MI1DI is opening the MIDI
Preferences on the Preferences Submenu on the File Menu. When you
choose this command, the following dialog will appear:

‘MID) Preferences.

[ Sptit channels on incoming MIDI files

Default output port: Wavestati... v
Timecode output port: | ADAT Input

(cancer ] [[ ok

Use this dialog to set the following characteristics for DECK II:

Split channels on incoming MIDI files: When this preference is on,
DECK II will split the channels when you import a MIDI file. This is
useful when you are importing Type 0 MIDI files, which store all track
data in one channel.

Default Output Port: This pop-up lists your MIDI ports and uses the
first one on the list as the default output port. To change the port,
simply select a different port using the pop-up menu.

Timecode Output Port: This pop-up controls through which port
outgoing MIDI Timecode is sent. To change the port, simply select a
different port using the pop-up menu.

Note: If you plan to import large MIDI files, you should first increase the
MIDI buffer size in the Memory and Storage Preferences. Remember,
whenever you increase the buffer size, you should also increase the
amount of RAM allocated to DECK II. For more information, see the
Memory and Storage Preferences in the Reference section of the user
manual.

You have now finished configuring your MIDI setup and can use any of
DECK's MIDI functions.

SENDING MIDI TIMECODE

You can use DECK II as a timecode master very easily. Simply choose
the Send Timecode command on the Options menu. Deck II will auto-
matically generate timecode and send it through the Timecode Output
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Port you chose in the MIDI Preferences. To stop sending Timecode,
choose the command again. You can tell if DECK Il is sending timecode
by looking for a check next to the command. If the command is checked,
DECK IIis sending Timecode.

IMPORTING MIDI FILES

If you do not own METRO (OSC's full-function sequencer) but would
like to hear a MIDI file that you have created in a sequencer play back
with your Session, you can use DECK II to import the MIDI file. First,
open up the MIDI window (choose MIDI from the Windows Menu.) It
will look like this:

Click on the Import Button. This will bring up a standard file dialog
asking you to pick a file to import. When you have opened the file,
DECK II will take a few moments to translate the file. When DECK Il is
finished importing the file, the MIDI window will look something like
this:

— " House One

bale i
“SynBass 2

Lo Sweeper

Syn String

You can change the MIDI file that is played with the Session by clicking
on the Import button again and choosing a new file. DECK II will erase
the previous MIDI data to make room for the new file.
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MIDI files are imported with their tempo maps, and DECK II will play
back those tempo maps AND display audio bar/beat data according to
those tempo maps. To view audio waveforms visually adjusted to
tempo-accurate bar/beat display, just choose Beat on the Option menu's
Time Mode submenu.

Important: DECK II's tempo indicator only shows you the first tempo of
any MIDI file. The display is not updated to show each new tempo.
Entering a new tempo will clear out the existing tempo map and set the
Session to that single new tempo.

Note: You can also use the Import MIDI File command on the File Menu
to bring up the same dialog. You can use the Dispose MIDI File com-
mand on the same menu to erase the current MIDI file without import-
ing new data.

If you plan to make changes to your current MIDI file, you can turn on
the subscribe button. This will enable DECK II to reflect those changes in
your Session. For more information on the Import and Subscribe func-
tions see the Reference section of the user manual.

MIDI THRU

Another of DECK II's MIDI functions is MIDI thru. To use MIDI thru,
open up the MIDI window, and press the button on the Thru track. It
will look something like this:

Deck II will take all MIDI events coming into the in port and send them
back out the port you choose on this track. You can change the port by
clicking on it and selecting a new port using the pop-up menu.

QUICKTIME ENHANCEMENTS

Version 2.2 of DECK I offers some simple, but important QuickTime
enhancements. Perhaps the simplest of this is support for QuickTime
2.0. At the feature level, version 2.2 now offers the ability to center the
QuickTime movie on its screen (available on the QuickTime menu) and
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support of new 16-to-8 bit conversion schemes, including rounding and
dithering (available under the Levels preference on File menu's Prefer-
ences submenu).

The most interesting new QuickTime features are scrub video (which
allows you to drag smoothly through video on your hard disk) and
scrub-to-spot (which lets you select an audio region in the Track win-
dow, and drag through video frames to spot that region on a specific
frame). Here's how they work:

To scrub video direct from the drive:
1) Open or create a DECK II Session
2) Import a QuickTime movie using the Import Movie com-
mand on the QuickTime menu. The QuickTime movie
appears in a window.
3) Place the mouse cursor over the QuickTime window. Then

click and hold down the mouse button. The arrow cursor
changes to a right-left triangle as shown below:

4) While holding the mouse button down, drag to the left
(earlier) or right (later) to scrub video directly from the
drive. Let go of the mouse button to stop scrubbing.
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To use scrub-to-spot:
1) Open or create a DECK II Session

2) Import a QuickTime movie using the Import Movie com-
mand on the QuickTime menu. The QuickTime movie
appears in a window.

3) Select an audio region or group of regions in the Track
window.

3) With one or more regions selected, place the mouse cursor
over the QuickTime window. Then click and hold down the
mouse button. The arrow cursor changes to a right-left
triangle.

4) While holding the mouse button down, drag to the left
(carlier) or right (later) to find the video frame upon which
the selected audio should start. Then let go of the mouse
button to auto-spot the selected region or regions on that
frame.

When you let go, the entire Track window selection will be
moved so that it starts on the frame you chose. Use this
function for quick spotting of sound effects of music edits.

Note: Remember, Sessions are set to have a nominal length of 10
seconds if they contain no audio. If you wish to play back an QuickTime
movie with no audio loaded, use the Session End Time command on the
Session menu and set the Session length to be longer than the movie
duration.

VIRTUAL MIXING

A Virtual Mix command is now available on the Process menu.

This command controls which tracks DECK II will mix when you choose
the Bounce or Mix to Disk command. When this command is off, DECK
IT will mix only the four to twelve active Play tracks. This will create a
mix that sounds exactly the same as when you play the session. How-
ever, when this command is on, DECK II will also mix whatever audio is
on the Work tracks. Because DECK II's automation follows the playlist,
this allows you to create a much more complex mix.
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LIBRARY WINDOW

The DECK II Library Window offers you an easy way to organize your
source material for quick pasting into the Track window. You can view
and use the Library Window by choosing the Library Window command
on the Windows menu.

The first column in the window shows you the names of the regions you
have placed in the Session using the Add Audio command. The second
column shows you the length of the region, and the third column shows
you the location on your hard drive of the associated audio file. You
may paste a region into the Track window using one of two methods.
The simplest method is to click and hold on the desired region. The
cursor will change to an arrow. Move the mouse into the Track window,
and let go of the mouse button over the desired location. You can spot
audio quite accurately using this method by observing the current time
in the data indicator boxes. You may also copy and paste from this
window into the Track window.

Hint: If you are importing large quantities of material, use the Add
Audio dialog to import all of it. Then use the Library window to spot
the regions accurately, rather than pasting them directly into the Track
window.

The Library window will only show regions that you have imported into
DECK II. If you want to see all regions in your Session in this window,
select the Update from Session command from the new Library Opera-
tions Submenu in the Session menu.

A NOTE ABOUT STEREO RECORDING

Please note that within DECK it is possible to record two tracks in stereo
by record-enabling two separate tracks simultaneously; be sure to assign
input 1 to the first track and input 2 to the second track. Inorder to
achieve true stereo separation during playback, remember to pan both
tracks hard left and hard right respectively.
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APPLE EXTENSION CONFLICTS

For optimal performance, please remove these and any other third party
Extensions from the Extensions Folder within your System Folder.

e Apple CD-ROM driver
» Filesharing Extension

e Serial Extension

e DAL

e Express Modem

There have been a number of reported problems which real-time pro-
grams such as DECK II might encounter when the Apple CD-ROM
driver is used. If you experience problems when using your Apple CD-
ROM, please contact OSC for a recommended CD-ROM driver replace-
ment.

OPCODE'S OPEN MUSIC SYSTEM

OSC recommends installing OMS when using DECK 11 for MIDI-
intensive applications (such as running METRO or syncing to external
MTC). In fact, OMS is required when using a multi-cable MIDI interface
stich as the MIDI Time Piece, Studio 4 or Studio 5.

ALLOCATING MORE RAM 10O DECK Il

In many instances DECK II will require more RAM than the amount pre-
allocated as the factory default. In fact, when working witha DECK I
Session approaching an hour’s length or more, OSC suggests you add at
least 3MB additional to DECK 1I’'s RAM partition. DECK Il is unique in
that it can display a file overview of any length—anywhere from milli-
seconds to minutes to hours. Therefore, special attention must be paid to
DECK II's RAM allocation partition. The following steps detail the
method for increasing (or decreasing) DECK II's RAM partition:

1) Quit DECK II, or be sure that DECK Il is not running.

2) From within Finder, select the DECK I program icon
(single-click on the DECK II program).
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3) Choose Get Info from the File menu.

4) Within the Get info dialog, increase the RAM partition
size in the Preferred Size field to a number that will run
comfortably within the confines of your machine’s installed
RAM (remember to leave enough free RAM for the System
and any other applications you wish to run in tandem with
DECK II). User’s with only 8MB RAM should not allocate
more than 6000K to the DECK application.

5) Close the Get Info window. DECK II will now remain at
the newly designated RAM partition size.

Note: Choose About This Macintosh under the Apple menu from
within Finder in order to keep track of unused RAM, System RAM,
application RAM, and total installed RAM.

RECORD MONITORING AND INPUT LEVEL SETTING
ON POWER MACINTOSHES

Power Macintoshes require the use of the 16-bit Sound Manager for
audio input and output. This version of the Sound Manager comes
installed on these systems. The Sound Manager forces some restraints
on input level settings and record (playthrough) monitoring. Hereis a
detailed description of these restraints:

Input Level Settings: The input level on Power Macintoshes can be set
from within DECK II using the Audio Input Level popup at the bottom
of the Options menu. It is important to realize that this popup lets you
set the level of a low-quality built-in preamplifier. This means you can
boost the level of any incoming signal, but any boost will noticeably
degrade the quality of the signal. For best results, set the Audio Input
Level to '0' and turn up your audio source (instrument or mixer) until it
registers well in the input meters. Remember, a setting of zero does not
turn off the input. It turns off the low-quality on-board preamp.

Record Monitoring: The Sound Manager imposes some limitations
where record monitoring is concerned. Record monitoring is the process
of 'listening back' to the signal being recorded. Normally, DECK I
allows you to adjust the level of the record monitoring during recording,
however this is not supported by the Sound Manager. For this reason,
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you cannot change the monitor volume or pan of any track that is being
recorded. (Of course, these settings can be altered dynamically once the
track has been recorded.) That means that recorded tracks will always
echo back through the system at their full volume, and will monitor
through the channel set as their input channel. (In other words, you
cannot record from input 1 and monitor through output 2.) Note also,
that recording on a single track from a single input will always automati-
cally monitor back through both outputs. Until Apple changes the
Sound Manager (or OSC creates special technologies to alter these
conditions), you can always compensate for these constraints using an
external mixer.

How TO COMPACT SESSIONS: A REVIEW

The Compact Session command (on the Session menu) is a command
that allows you to recover any disk space occupied by unused takes and
other throw-away audio. It is a very useful function, but you must use it
carefully to make sure you don't throw away important audio. Here's
how to Compact your Session:

1) Enable Rewrite Region list under DECK’s General Prefer-
ences on the File menu.

2) Delete all unwanted audio regions from within the Tracks
window (remember this includes Work Tracks).

3) Open the Library Window.

4) Choose Update Library From Session on the Session menu's
Library Operations submenu.

6) Choose Save on the File menu.

7) Choose Compact Session on the Session menu. You can now
set the handle length (explained in the DECK Il manual) and
the compaction will be executed.

Note: For safety purposes, only audio files contained within the
current Session’s audio files folder will be affected by the Compact
Session command.
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THE SESSION INFO DIALOG

DECK Il version 2.2 contains a new Session Info dialog that tells you
quite a bit about the current Session and allows you to view, play,
rename and delete audio files associated with the Session.

To see Session info:
1) Open a Session in DECK 1L

2) Choose the Session Info commmand on the Session menu.
This dialog appears:

Free RAM: 6569kB
Free disk space: 11MB
Sample Rate: 44100
Free automation events: 3071
Free MIDI events: 19999

Flles in sesslon:

Audio/lideo:Desktop Folder:Bbs jgri:Bbsjgrf audio files:PlayList 4fis
Audio/VideoDesktop Folder:Bbs jgrv:Bbs jgrf audio files:Mix File 355831

Audio/Video:Desktop Folder:Bbs jgrf:Bbs jgrf audio files:Playlist
Rudio/Video:Desktop Folder:Bbs jgri:Bbs jgrf audio files:PlayList

((show ][ pay )( mename [ Delete |

This dialog shows you the Session’s vital information, and a
list of the audio files associated with the Session. To view,
play, rename or delete audio files, just select the audio file
and click on the desired button. Note that the Showbutton
will actually take you out to the Finder and select the audio
file you have highlighted.

Note: When you want to rename audio files, make sure to use the
Session Info dialog's Rename button. Simply renaming the file in the
Finder will force you to ‘refind' the file the next time you reopen the
Session. DO NOT switch out of a Session and rename a file while the
Session is still open. This can cause unpredictable results.
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EXPORTING WAVE AuUDIO FILES

Version 2.2 of DECK allows you to save any audio file or audio mix in
the WAVE (WAYV) format for use on the PC platform. Here'show to do
it:

To export files in the WAVE format:

1) Open the DECK II Session that contains the file or tracks you
wish to export.

2) Solo the track or tracks that contain the regions you wish to
export.

3) Select the range you wish to export using either the Object
{hand) or Range tool.

4) Choose the Mix to Disk command on the Process menu.
This dialog appears:

7~ Folder File Drive Options

90T Test =
shing & yake fject
s
LT 1.0 wro sauns Desktop

d Ciggitad Bliee
Ty e

Mi o file Cancel
[MIKDOWN.WAY |

0
s
o
2
g
3

Save

Format: [ Wave ¥

sample Rate: | Full Session v|
Bit Depth: | 16 v|
Number of Channels: | Slereo 'I E

5) Name your mix and select a destination folder.

6) Use the Format popup menu to select the Wave format.
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7)

Click on the Save button.

After a few moments your Wave-format audio file will
appear in the selected destination folder.

EXPORTING 8-BIT AUDIO WITH DITHERING OR
ROUNDING

One important change in DECK II version 2.2 is the addition of high-
quality 16-to-8 bit conversion schemes. These schemes make it possible
to create reasonably good-sounding 8-bit mixdowns from your 16-bit
DECK source audio. In the past, DECK II only offered truncation as a
conversion method, which generally produces poor results, especially on
lower-level signals. Version 2.2 also offers two rounding methods and a
dithering method. Here are directions for using them, and explanations
of what they do:

1) Open the DECK II Session that contains the file or tracks you
wish to mix or export at 8-bit resolution.

2) Solo the track or tracks that contain the regions you wish to
mix/export. '

3) Select the range you wish to export using either the Object
(hand) or Range tool.

4) Choose the Mix to Disk command on the Process menu. The
Mix to Disk dialog appears.

5) Name your mix and select a destination folder.

6) Use the Bit Depth popup menu to select the 8-bit output.

6) Use the Bit Depth Conversion Method popup menu to select
the conversion method you desire (explained below).

Bit depth conversion method: | Dithering v |

You can also set this under the Levels preference found on
the File menu's Preferences submenu.

22
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7) Click on the Save button.

After a few moments your 8-bit converted audio file will
appear in the selected destination folder.

Here are explanations of the different bit depth conversion methods:

Truncation: This method simply takes the high byte as the sample
value and throws away the low byte. Truncation often causes unpleas-
ant artifacting, especially on low-level signals and human speech.

Rounding: This method treats the 16 bit sample as a fixed point number
with the decimal point between the bytes. If the fractional part (the low
byte) is greater than or equal to 0.5 then 1 is added to the high byte
(hence rounding') and the high byte is taken as the sample value.

Convergent Rounding: This method differs from rounding in how it
treats the value of 0.5 in the low byte. 1 isonly added to the high byte if
the low-byte value is equal to or greater than 0.5 and the high byte is
even. Otherwise the high byte is taken as the sample value.

Dithering: Dithering applies a low-level 'noise' signal, which is used to
'mask,' or cover up the unpleasant artifacting created by truncation. Itis
also called error diffusion dithering.

The results of these conversion methods very much depends on the
source material you use. Generally, rounding and dithering will pro-
duce better results than truncation. You will need to experiment with
these settings to see which method works best for your material.

CONTINUOUS RESYNCHRONIZATION AND PITCH
CONTROL

As most users of synchronization know, DECK II is capable of software-
based continuous resynchronization to SMPTE timecode. (In fact, DECK
II's native setting is continuous resync, as opposed to trigger sync.) This
is explained at length in the main user manual. However, users of DECK
II on AV and Power Macintoshes should be aware of a few special notes.
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AV Macintoshes and Power Macintoshes are not capable of performing
real-time sample rate conversion tasks with track counts of more than
four tracks. This impacts users in two arecas: First, the Transport
window's Pitch control will automatically switch off tracks 5 and above
while pitch is being set or changed. Resetting the pitch to zero (0)
change will turn on all tracks again. A message will appear to inform
you of this. The second point concerns continuous resync. When
syncing DECKII to external SMPTE on an AV or Power Macintosh with
more than four tracks set to play, trigger sync will be turned on auto-
matically. To avoid this autoswitch and retain continuous resync, you
will need to mix down your tracks to four playback tracks, or set the Max
Play Tracks to 4 using the Memory and Storage preference on the File
menu's Preferences submenu.

TROUBLESHOOTING TIPS AND SUGGESTIONS

Power Macintosh and AV Model Tips and Suggestions:

Cannot record in stereo; no stereo separation:

e Make sure you are using stereo, as opposed to mono,
adapters on the AV’s inputs and outputs. The illustration on
the next page shows stereo mini-plugs.

e Be sure that your adapter fits snugly in the input and output
sockets.

¢ Remember to set each record track to a different input. Do
this by dragging on the Input number near the top of the
channel's mixer module:

click and drag here
(up or down)

Scratchy-sounding audio:

e Be sure to use a stereo 1/8” adapter (1/2” tip) with a with a
tapered base that is slightly raised above the adapter's
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casing. The input socket on the AV will prevent certain “flat
headed” 1/8” adapters from making full stereo contact.
Refer to diagram below:

Not OK

Remedies for clicks and pops on Mac AV machines:

Install asynchronous SCSI Manager 4.3 compatible drivers
on all external SCSI devices (OSC recommends the Anubis
Drivers V2.5.1 [or higher] from Charismac Engineering).

Install HD SC Setup V7.2.2 (or higher) on Apple internal
hard disk.

System 7.1 users must install Hardware System Update V3.0
(from Apple Computer) to optimize the System software to
better run on AV machines.

It is important to record audio data to a hard drive that does
not contain the System Folder (for this reason, two disk
drives are recommended for Mac AV machines).

Install A/ROSE v1.2 (from Apple Computer) into the
Extensions folder to avoid “Floating Point Coprocessor not
installed” errors.

Set Memory Control Panel Disk Cache Size to 32K. If clicks
persist, begin working upwards (64K, 96K, 128K)—try not to
exceed 128K.
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If you are using a Digidesign card

You get a -2500 series error when you try to record.

This error will generally only appear if you are running a
Digidesign system along with 16-bit Sound Manager (ver-
sion 3 or higher). If you are doing this, make sure to remove
your Digi Sound Drivers document from your Extensions
folder. In certain configurations, these drivers may make it
impossible to record into DECK.

General Advice:

Extension/Control Panels Management:

Apple’s Extension Manager program, available free on most
BBS’s, comes in extremely handy for general troubleshooting
practices, as well as maintaining custom Mac environments
optimized for specific applications, such as DECK and
Metro. Extensions Manager comes pre-installed with
System 7.5.

Disk Defragmentation/Optimization:

Do not use “split” mode in Disk Express II to optimize your
hard drive — “split” mode fragments your files beyond
playability. For this reason, OSC has found that Norton
Utilities’ Speed Disk program is much better suited for
defragmenting large digital audio files.

Problems Initializing Playback Engine:

Try throwing away DECK Preferences, from the Preferences
Folder within the System Folder, if receiving the error
message “Problems Initializing Playback Engine. Audio
hardware may not be supported”. DECK will automatically
create a new Preferences File reverting back to it’s factory
default settings and this usually rectifies the problem.

DECK users with Digidesign hardware must also throw
away the DigiSetup and DigiCommFile (if available) files
from within the System Folder. Both files will be automati-
cally recreated.

26
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RAM-Related Problems:

Allocate more RAM to DECK II's memory partition remedy any of the
following errors:

* Calculating File Overview dialog continually appears when
attempting to scroll or navigate through the Tracks window.

¢ Couldn’t complete the last command because of a Mac OS
error. -108.

* Couldn’t complete the last command because of a Mac OS
error. -2012.

* Increasing DECK II's HD Buffer Size within Memory and
Storage Preferences without, in turn, increasing DECK II's
RAM partition usually results in the error “Problems
Initializing Playback Engine. Audio hardware may not be
supported” when attempting to relaunch DECK II.

Rectifying -39 (End of File) Errors:

The -39 error signifies an “end of file” error in which a region’s start and
end times have somehow become corrupted. These errors can occur
when importing regions from files originally saved in Sound Designer II.
There have also been a few reported instances of these errors during
playback within a DECK II Session. Both instances of this error can be
remedied using the following steps:

-39 error during playback:
* Take note of which region (or regions) is actually causing the
-39 error (DECK will usually stop playback the exact instant
it hits the start point of the problematic region or regions).

* Take note of the problematic region’s original position.

* In Object mode, Trim the problematic region inwards (to
make the region smaller).

* Trim the region a second time and extend it back to its
original duration.
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e The -39 error should now be rectified since the region’s start
and end times have now been redefined by the Trim tool.

-39 error when importing from regions originally saved in SDII:

* Rebuild the Desktop File on all of your drives (Restart your
Macintosh while holding down the command-option keys).

¢ Load SDII and redefine the problematic region(s).
¢ Save the audio file within SDIIL.

» Import the region(s) into DECK II via Add Audio to Clip-
board.

DECK Il KEY COMMANDS AND SHORTCUTS

One of DECK II's strongest features is the deep implementation of key
commands and shortcuts to speed up editing for the advanced user.
Here is a comprehensive list of the different key commands and short-
cuts in the DECK I interface:

TRACK WINDOW:

I T T L U o zoom in wave amplitude

J cisgbsnpgrigensipsepmivsspsissinassansnsnasnsommapias fonnsiine cners EROPOUL WA YE amiplitude

C rrranrsnenssnsiimnsnisssnssssnsnse s ssssssmnsneneenensss. (UTNS CUE l0OP 0N and sets cue
from current selection

D s sivsris e assssesss INOVEdp. panct locatinn titoa

USRI oo mveusevnonscomamnassusasoasiionsinsiSUATIRIRRALEERSH move to previous location time

CIEET pusonprosismmsiisnsspsmssssgssnsenapiuusnnssomasssmmsssasns SHIEERS NEW: JOcCAtion time during
playback

e T LI B moves selection 1 frame ahead
in time

... moves selection 1 frame back in

time

TELUT L ssoarss rosssusnsssriassonseoporanssssesasineppopnns Susas return to zero

AL A=) arssronsnsasmaiissorivsssisssvssssssiasssssossnburadds toggle between Range and
Object modes

SPRCEDRY. .o oupsssgonpisisertrssonsiguas ipperssarnpessiisirssssonPlOY /iStOR/ comtinue

control-spacebar ...........cocvvvvvvvrivsrrinnnne.n. play from last insertion point

L T M SR—

... audition selection
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OPHIONC 1y nuarspyesssithsmsesisassonses stagsssssisssssen assens turns cue loop off

OPHON sppbinsnsserrte wiotessing yepasyepgep s oressssoms full zoom in wave amplitude

OPHON=] vevrvvcressssessnsarssssnassssssoansassssssnsenasessas full zoom out wave amplitude

COMMANA=L . ivvvivresssnsnsessnsesisssessssssernss s nnnres jUMP t0 left of selection

COMMANI L 1r1erompoagssgumnss tassssnsnsssssapsivnvosss sasasssss jump to right of selection

AYTOUW KEYS 1osernpravsasmpssravsnsiesssnsanssrisssssssosse nses move selection up/down/left/
right

command left/right @rrow .......ccomecrecinnns move selection by current
Nudge time or Grid Unit

option-click on magnifier ... zoom in/out 2X

shift-option-click on magnifier ............... zoom in/out 4X

command-click on left magnifier (-) .......... zoom full out

command-click on right magnifier (+) ...... zoom full in

command-click on fit selection ................... fit selection towards right

option-click on fit selection ......coveeieeiens fit selection towards left

option-click on track view display ........... change all track displays to new
views mode

option-click on automation mode disp..... change all track automation
displays to new mode

command-click on Playlist name ............... rename Playlist

command-click on volume display ............ brings up volume text entry
dialog

command-click on panning display........... brings up panning text entry
dialog

option-click panning slider.......ccceevnniens sets pan position to center

option-click volume slider .........coceiins sets volume slider to 0dB

command-click on horizontal scroll bar .... moves Track window view by
half screen increment

command-shift-Option-u ......conrerrrnes recalculate all region overviews
L7 LT — fit marquee to full screen

without changing selection
S-TVAG voerunrarrosssnnisasss Siaprsiysigogesgigppsssss sassssases solo scrub current track
OPHON-S-ATAZ cvvvrvvirrereceriisissiisssisnins s scrub all tracks
OPHON-COMMANAD 1oreveeeviersvnsrisesssssnnces i Paste At

TRACK WINDOW (RANGE MODE ONLY):

B-CHEK i samesasisinisises s sonserssssas select whole region or empty
space between regions

SHIE-A-CHCK 1ovovsmsnnssossssmsnnssssssssmssossssssan sonsiens extends selection/insertion
point to region boundary

OpHON-SHIft-A-CHECK vovvvvevrrrne e extend selection/insertion point

to beginning/end of Session
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shift-a-left{right arrow ..........ccccovcevvnnnnae. extends selection/insertion
point to region boundary

option-shift-a-left/right arrow ..................... extend selection/insertion point
to beginning/end of Session

g (- el AR, IS AL &t KL fit new selection to full screen

option-left/right arrow ..........ccccvivvvvinnrnane, move selection left/right by
selection amount

control-left[right arrow...........ccovvvevereeecenn, collapses selection to left or
right

shift-left/right arrow......................cc............ extends selection to left or right

TRACK WINDOW VOLUME OR PANNING VIEWS:

Shift-ClCK w.covvuvvrviisesrisssiirasirissnsssisss s svnnnne ... ON €XiSting automation event to
constrain time

command-click .....c.ovueiiveicniiviiesiiireennnn. enters new automation
breakpoint

control-command-click ............c.oovevereenc...... €Nters new automation break
point with same level as preced-
ing breakpoint

TRACK WINDOW VOLUME OR PANNING VIEWS (RANGE MODE
ONLY):

CONArol-Click ....cvovvuesrreresrs e trevranes... ON €XiSting automation event to
constrain level or percentage

TRACK WINDOW VOLUME OR PANNING VIEW. BJECT

MODE ONLY):

CONErOl-ClCk ....ovvvvviviievveiivirsiv s e O @UtOMation event to bring up
event entry dialog

(oo i TGl B by (1 S —— nudge up selected automation
points pixel by pixel

Command-down arrow ............cocecerurenenens nudge down selected automa-
tion points pixel by pixel

command-left Arrow ... eeveeerverriiisenenn nudge left selected automation
points pixel by pixel

command-right Ar1owW ...........evewsevsiniscnnans nudge right selected automation
points pixel by pixel

command-option-left/right arrow ................. copies selection to left or right
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TRANSPORT WINDOW:

control-click on location time............oco.... to bring up associated begin-
ning and end times

option-cliok ON COUNLET ......comvmiisiossonssininns scrolls Track window to counter
location

QUICKTIME WINDOW:

eI ehE BT IO s amm R R move QT movie backwards/
forwards by a single frame

UPJAOWN ATTOW oo move to beginning/end of QT
region

LIBRARY WINDOW:

SHIfL=SPACEDAY. 1ivvvsvsisssssivissinsisnnsipesinssivareansnns audition selection

MIXER WINDOW:

option-click panning slider ........c..ccc.cco.e. sets pan position to center

option-click volume slider .........ccoeveiveienens sets volume slider to 0dB

command-click on volume slider ............... brings up volume textentry
dialog

command-click on panning slider .............. brings up panning text entry
dialog

command-click on Input number ............... enter Input numerically

command-click on panning output............ enter panning output numeri-
call

click onuppet VU LED s annminis rese); individual Clip Indicator

option-click on upper VU LED .................. reset all Clip Indicators

command-click on Playlist name ............... rename Playlist

That concludes the DECK II 2.2 Manual Addendum. Please consult your
DECK II manual for any other information.
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